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Overview 

The SiteManager software provides a complete alert and status call capture, management, and 
archiving environment for the plus family of PageTek monitors. The SiteManager: 

�� Logs all inbound alert and status calls and stores the messages for later retrieval and analysis. 
�� Alerts technical staff whenever scheduled status calls are not received. 
�� Synchronizes monitor clocks automatically. 
�� Provides two levels of staff access rights. 
�� Provides a database of all monitors with user notes capability. 
�� Filters received alert calls by a variety of parameters. 
�� Tracks monitors and technician responsibilities by region. 
�� Schedules  technician alerts by region and time. 
�� Provides user-friendly messages derived from monitor alerts using a user-specified lexicon. 
�� Supports local and pager notification of technicians and/or operators. 
��  Supports e-mail notification of technicians, operators, and managers. 

 

The SiteManager is recommended when the volume of messages from any network of PageTek 
monitors becomes sufficiently large to reduce technician efficiency or performance, or when archiving 
of system performance is required. The SiteManager software communicates with the monitoring 
network via the public telephone network. It is not required or meant for local interaction with PageTek 
monitors. Many aspects of the SiteManager software are configurable by the user, but the system is 
designed to achieve this functionality with a minimum of complexity. 
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Installation 

Hardware Requirements 

�� 32 MB RAM 
�� 50 MB Free Disk Space 
�� VGA or Higher Resolution Monitor 
�� Mouse 
�� Two or more 14,400 bps (or higher) modems 

 

The SiteManager software is fully compatible only with the ProTekTor+ ROM version 1.4 or later, jr+ 
ROM version 2.06 or later and 24+ ROM version 4.1 or later. SiteManager may be used with a mixed 
network of plus and classic monitors with some reduction in functionality as discussed in the Working 
with a Mixed Network in Chapter 5. 

SiteManager is designed to be installed on any computer running a standard installation of Microsoft 
NT 4.0 or 2000. The SiteManager installation procedure installs all additional files required for 
operation. As with all Windows® programs, performance may be improved with additional RAM, but as 
the SiteManager application is not particularly memory hungry, 32 meg of memory is adequate. Due to 
the compact nature of the alert and status call logs, more than a year’s worth of logging may be 
maintained on most modern hard drives. It is wise to reboot the NT machine periodically to clear out 
junk left in memory by the operating system, especially if other applications are also run on the 
machine. This is a well-documented shortcoming of the operating system rather than a fault of the 
SiteManager software. This is expected to be less of a problem with Windows 2000. 

Installation Instructions 

1) From the Start Menu, select Run and enter “D:\setup.exe” where “D” is your CD drive. 
2) Follow the onscreen instructions to complete the installation. 
3) Reboot the computer after the installation is complete. 

 
If a previous version of SiteManager is being updated, that version should be uninstalled using the 
Microsoft Add/Remove Programs utility in the control panel. The uninstall will leave the previous 
database file in the directory for future use. The newly installed SiteManager will automatically import 
and convert the old database and its contents to the expanded database structure required by this 
version of SiteManager. 

License Key Entry 

Any time an unregistered copy of SiteManager is opened, nag dialog boxes will periodically remind the 
user to register the application. While the application may be registered as a demo or a permanent 
installation, both installations require a key to be entered for normal operation. During a demo’s life 
span, there will be no nag boxes, though the nagging will start again when the demo life span expires. 
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A permanent installation will never present the user with nag boxes. Be sure to record the license key, 
especially when performing a permanent installation. The size of the monitor database supported by a 
SiteManager installation is dependent upon the License Key. Users may upgrade to a larger network 
capability by contacting PageTek for the required key. The License Key will be found on the title page 
of this manual. 

To register the application perform the following steps: 

1) Select File > License 
2) Type the License Key in the License Key dialog box that opens and click OK. 
3) Confirm a successful licensing by selecting Help > About SiteManager. The information just 

entered should be indicated. 
 

 
Figure 2.1 

SiteManager Password Entry 

The SiteManager software supports two levels of access rights. An operator has read-only access to 
SiteManager information displays, but no configuration or control capability of either the SiteManager 
software or the monitors reporting to the SiteManager. The technician password gives full read/write 
capability to the user. Commands not available to the Operator are visible on the menus but are grayed 
out and are non-functional. Under Customize, grayed out commands are Regions and Scheduling Alert 
Descriptions and Filtering are not visible at all except when logged in as Technician. In the Units editing 
box, the ADD and DELETE commands are not available to the operator. The SiteManager software 
must therefore be installed by a person holding the full read/write password rights. The default 
password for the operator is appropriately enough, “operator”, while the default full access password is 
“technician”. Obviously both passwords should be changed following installation. The default full-
access password of technician should be used for commissioning SiteManager. 

Default Passwords 

�� Limited access: operator 

�� Full access: technician 

Changing Passwords 

The technician may change the Operator or Technician passwords by use of the File > Change 
Passwords menu Password command. Two passwords may be set, one for limited access and one 
password for full access. A dialog box entitled Change Passwords will appear, indicating the current 
password, either of which may be edited by conventional Windows®  procedures. Pressing OK will 
save the passwords and exit, while pressing cancel will exit without saving the passwords.  
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Figure 2.2 

Modem and E-mail Setup 

After installation, you may receive a warning that you need to configure your modems the first time you 
run SiteManager. Regardless, it is wise to confirm that SiteManager has correctly recognized the 
modems. Improper modem setup is the most common cause of SiteManager misbehavior. 

To configure your modems, go to File and select Properties in the menu. 

In the Properties Listening Modem combo box, select the modem that will receive the incoming alert 
calls. If required, click on the appropriate Properties button to set up the modem operational 
parameters. 

4) In the Properties Outgoing Modem combo box, select the modem that will initiate outgoing 
calls to the monitors. This cannot be the same modem specified in the Listening Modem 
combo box. If required, click on the appropriate Properties button to set up the modem 
operational parameters. 

5) In the E-mail Server field enter the name of the outgoing mail server. This will frequently be 
something like smtp.yourdomain.com. 

 

 
Figure 2.2 

If either incoming or outgoing modems are not found in the Properties drop down menu, confirm that 
they have been properly installed by using the Modem applet in the operating system control panel. 
The installed modems may be confirmed by using the Start > Settings > Control Panel > Modem 
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command path. Further customization of the modem behavior including initialization strings, must be 
performed using the modem applet in the control period. 

A note about screen resolutions 

The SiteManager application will work with a screen resolution of 640 x 480 or greater. While smaller 
monitor screen sizes will generally be required to run at lower resolutions, a screen resolution of 800 x 
680 or more is generally satisfactory on larger monitor screens. All major windows are automatically 
maximized to full screen to ensure legibility and focus. If the font size is felt to require adjustment, such 
adjustment is frequently available using the video card setup procedure. 

Advanced Programming 

At this point, the SiteManager software has been installed on your computer but further configuration is 
required to activate the Status Call monitoring, build the monitor database, configure the user-friendly 
alert notices, etc. As these configurations are heavily influenced by your needs, we will separately 
discuss the programming of these facilities in Chapter 4. 
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Using SiteManager 

The SiteManager uses two main windows for most user interaction, namely the Alert Call and Status 
Call windows. All other user/SiteManager interaction uses smaller windows or dialog boxes. All 
windows found in SiteManager follow Microsoft Windows® conventions. Both the Status Call and Alert 
Call windows have the current date and time in the lower right-hand corner of the window. The 
communications status is generally displayed in the lower left-hand corner of the windows.  

The Alert Call Window 

 
Figure 3.1[mrball6] 

 
The Alert Call window (see Figure 3.1) is the primary activity window for the PageTek monitor 
SiteManager. It contains a single large frame in which all received alert calls are listed. If the number of 
alert calls exceeds the space available in the frame, a scroll bar appears on the right hand side. Using 
standard Windows®  procedures, the user may scroll to those calls temporarily hidden. At all times, the 
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alert calls received within the last 30 days will be available. Alert calls older than 30 days will be 
automatically archived to the SiteManager directory. Below the list window is a gray area in which 
details of any highlighted entry will be displayed. 

Accessing and using other programs 

The Alert Call window will open maximized and occupy the complete desktop. The Alert window may 
be minimized to provide access to the operating system desktop. It is recommended that the task bar is 
set to Always on Top with Auto Hide disabled. The user may access the start menu on most modern 
keyboards by pressing the Windows key usually found next to the ALT key(s). Pressing the flying 
Windows key will bring up the Start menu in the NT 4.0 and 2000 operating environments, from which 
the user may access any applications or services. The alt-s key combination will also work on 
keyboards that are not Win-95 compliant. If multiple applications are already running, the user may 
cycle through these applications by using the alt-tab key combination. When running NT, the control-
alt-delete keyboard combination may be used to access the NT security dialog box and the Task 
Manager applet. Clicking on the X box on the (main) Alert Call window or selecting exit in the File menu 
will shut down SiteManager entirely.  

As the native format of the SiteManager database is the Microsoft Access compatible mdb, the various 
SiteManager tables may be exported directly to Access or converted to Microsoft Excel for analysis. 
Any information which may be printed, such as the Alert! And Status content may also be saved in the 
Adobe Acrobat format (PDF) using the freely available PDFWriter application, available from the Adobe 
web site at no charge. 

Alert Call Window Organization 

The Alert Call window displays all received alert calls and assigns them a unique event ID number. The 
ID number follows  the format yy/ddd-xxx, where yy is the last two digits of the year, ddd is the day of 
the year, and xxx is the number of the call received for that date. The most recent message will always 
be displayed as the topmost entry. 

After the unique Event ID number, the Site ID, Alarm Time, Input, Input Name, and Input Value are 
displayed. Note that the alarm time is the time of day at the reporting monitor and may not match the 
SiteManager computer system time. For this reason, it is recommended that Universal Time be used 
and that the Synchronize Time command is used frequently as is discussed in Chapter 4. In addition, 
the alert call is broken down into categories in the gray rectangle immediately below the alert call 
window. The Alert Call window will display all alert calls received during the previous 30 days. Once a 
message is more than 30 days old, it will be automatically archived and removed from the Alert Call 
window. 
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Figure 3.2 

Alert Reception and Processing 

Whenever an alarm is received from a site monitor, SiteManager will pop up the Alert! window and play 
the default Windows®  “beep” audio. The audio beep will repeat at 30-second intervals until the OK 
button is pressed to acknowledge the alert. The beep may be reprogrammed to any wav audio file 
using the Windows control panel Sound applet, but this will for present be a system-wide change.  
External signaling using a relay driver card may be supported upon request.  

When an alarm for a site arrives, that alarm may now be reported in a friendlier format that is more 
readily understandable by a non-technical person. In some cases, such mapping may require specific 
descriptors programmed in the monitor only if such use does not interfere with conventional use of the 
monitor. The SiteManager will parse the content of the monitor-generated message to retrieve values 
for insertion into local user-friendly message of a maximum of 255 characters. Configuration of this 
capability is accomplished via the Customize>Alert Description menu command path described in 
Chapter 4. 

Users may connect to any unit generating an alert call by highlighting the alert entry and clicking on the 
Call[mrball7] button in the lower right quadrant of the screen. A terminal session window will be 
displayed and the access telephone number specified in the unit database will be dialed. When 
accessing a site, the SiteManager will retrieve the appropriate password from the SiteManager monitor 
database and automatically transmit that password to the called unit during the automated log in 
procedure. The Call monitor function is also available from the Units Database window and performs 
similarly. While there is a Hang Up button on the terminal window , the user should continue to 
disconnect from the monitor using the TC command. The Hang Up function is available only after a 
connection has been established. 
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SiteManager will print the contents of the alert! Window directly to the default printer when the Print 
Selected (Ctrl+P) command is used. If a alternative printer is required change to that printer using the 
Page Setup command first. Printing to fax, PDFWriter, or text only file are other alternatives printers. 

The Status Report Screen 

 

Figure 3.3 
The Status report screen (see Figure 3.3) displays the logged status report calls received during the last 
30 days. Older messages are archived as they reach 31 days of age. The contents of the Status 
Window  may be printed using the Print Selected (Ctrl+P) command. 

The upper-right field displays a list of the status report calls organized by date received from the unit. 
The date and time displayed in this field represents the day and time SiteManager received the call, not 
the date and time onboard the PageTek monitor unit. If no status calls have been received from the unit 
highlighted in the Select Unit box on the upper left then a “none received” message will be displayed . 

The larger lower field displays the actual status report message as received by SiteManager. For a 
description of the information contained within this field, see the manual for the PageTek monitor unit. 
The contents of this window may be copied or  “dragged and dropped” to most applications capable of 
importing text files. To exit this form, click on the “OK” command button. 
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Programming of the reporting monitors 

When programming the PageTek jr+ or 24+ monitors, the listening SiteManager modem telephone 
number must be programmed in telephone list slot 1 under the Telephone Number Parameters screen 
(see Figure 4.1). The ProTekTor+ can send a status call to any number in the list but the SiteManager 
number should still be first in the calling sequence and specified to receive status calls. Failure to do so 
will result in the SiteManager not receiving status report calls from that monitor. Program any other 
telephone numbers you wish in the remaining telephone list slots. These would generally be the pager 
or telephone numbers of responsible local technicians. 

Figure 4.1 

 
Relationship of SiteManager to Monitor Data 

The relationship of SiteManager programming to the monitor programming is indicated below: 

SiteManager     Monitor 
Site Name     Site Name 
Site ID      Site ID 
Status Call Time     Status Call Deadline 
SiteManager inbound modem number  Phone Slot 1 
Monitor password    Password 
Time      Time 
Unit Phone Number     Monitor's telephone number 
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Time Stamping Considerations 

Finally, it is recommended that you program the system time and date for all monitors to the same time 
zone as the SiteManager computer. Users may find that the use of Universal Coordinated Time (UTC) 
is convenient when monitors are in separate time zones. This also reduces the need for a twice yearly 
clock synchronization due to changes associated with Daylight Savings Time. This will also avoid any 
confusion that may result from a possible discrepancy between the times when an alarm was triggered 
versus when the alert call was received. After the Site Manager’s database is set up, you may use the 
Synchronize clocks function under the File menu to synchronize the clocks for all the units. 

Synchronize Clocks Function 

The SiteManager can set the clocks for all plus series PageTek monitor monitors in the database. It will 
not synchronize PageTek classic monitors, nor plus series with outdated software. For proper operation 
the information contained in the units database must be accurate. However, an incorrect telephone 
number or password will cause the function to fail for that unit only; the function will continue setting the 
remaining monitors in the database. Any failure to synchronize a monitor clock will be reported in the 
alerts as a communications error. 

 

Figure XXX 

 
To perform the automated clock synchronization, select File > Synchronize clocks. A small dialog box 
will indicate that the calling sequence has begun, and will indicate the number currently being called by 
the function. Full functionality of the SiteManager is available during the entire synchronization process. 

There is almost certainly to be a small deviation over the course of months between the SiteManager 
time and that of the various devices calling into the SiteManager. Devices that are found to habitually 
deviate substantially from the correct time may require adjustment of the real-time clock, when 
possible. High accuracy real-time clock boards are available if the SiteManager’s computer clock is not 
sufficiently accurate. Various freeware applications are available that allow synchronization of a 
computer’s system clock with a network timeserver or with the National Bureau of Standards atomic 
clocks. Periodic use of these applications will ensure that the computer clock is accurate to better than 
one second. 

Using Status Call Monitoring 

It is highly recommended that all monitors be programmed to generate daily status calls. The status 
calls will confirm the continued operation of the monitors and ensure that all monitors are entered in the 
SiteManager database. If you intend that the SiteManager receive status report calls from the PageTek 
units, then you must program the PageTek units to send a status report call on a daily basis. Be sure to 
allow a large enough time buffer between the status report call time programmed onboard the PageTek 
unit and the status report deadline you will program in the SiteManager for the unit. When SiteManager 
does not receive a daily status report call from a monitor by that unit’s deadline, it will notify the local 
operator. If there is a high call volume and the SiteManager telephone line is busy, it may take a few 
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minutes for the status report call to get through. It is recommended that the SiteManager deadline for 
receipt of a monitor’s status call be at least 6 minutes after the time programmed on the monitor.  

Units Database  

As monitors call in with their daily status calls, they will be added automatically to the SiteManager Units 
database. If the daily status call is not programmed in any monitor, that monitor will have to be 
manually added to the Units database. Remember that the SiteManager will not add a monitor to the 
database if its SITE ID is already in the database, even if it is actually a new monitor with a different site 
name, location, etc. SiteManager however will add a monitor to the database even if you have 
previously added the monitor manually with an erroneous SITE ID. 

Since the SiteManager Units database will not allow duplicate entries, we recommend the user devise 
a system for creating unique SITE IDs, and use the system consistently. If no other scheme is in place, 
it is suggested that the monitor serial numbers be used for the ID to insure a unique SITE ID. The 
SiteManager will use this SITE ID to associate alert and status calls with a particular unit during the 
alert logging process. It is imperative that the monitor SITE IDs match the IDs in the SiteManager 
monitor database. Therefore, regardless of the ID system used be sure to record the SITE IDs 
programmed into the units because that information will be used when setting up the SiteManager 
database. 

 
Figure 4.2 

 
Adding new monitors to the database 

To manually add a PageTek monitor to the SiteManager database, click on the View menu and select 
Units. If this is the first time SiteManager has been run and no status calls have been received yet, the 
unit database will be empty. All entries will be sorted by Site ID number. You may access any particular 
known SITE ID by using the horizontal scroll bar along the bottom of the form. When the Units 
database dialog box appears, click on the Add button. 
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Figure 4.3 

 
When you have pressed the Add button, you should see the Add Unit form onscreen. Enter a Site 
Name that corresponds to the SITE NAME programmed in the PageTek monitor unit. Enter any 
descriptive name of up to 16 alphanumeric characters. Enter the four-digit SITE ID programmed in the 
monitor in the form’s Site ID field, ensuring that the ID is a four-digit number greater than or equal to 
1000. (This restriction is due to the tendency of some voice mail or telephone switches to incorrectly 
interpret a leading zero in a DTMF alert message as a command and may not apply to your situation.) 
Fill out the Add Unit form as desired, remembering that this information will be used by SiteManager 
when logging alert and status call messages and when performing the automated connection to any 
monitor in the database. The Location field identifies the physical location of the unit. Locations are 
stored in the database and may be used for more than one unit by selecting from the field’s pull-down 
combo box. The Password field corresponds to the PASSWORD for the PageTek monitor unit. 

The Unit Phone Number is the number that the SiteManager will dial whenever the various Call Unit 
buttons are clicked. The Units form will be displayed with the new unit’s ID number in the Site ID field. 
Enter the unit’s site name in the Name field, the unit’s password in the Password field, and the unit’s 
Status Report Deadline in 24 hour format (00:00 – 23:59). The monitor must be programmed to send a 
daily status call whenever a time is entered in this field. If the field is left blank, no status call monitoring 
will be performed for this monitor. If you enter a location that is not in the database already, that location 
will be added to the choices found in the drop down list associated with the field. Previously added 
locations will be available in the drop down menu. 

You may enter any miscellaneous information about the new unit in the User Notes box. Possible uses 
may include travel directions, special warnings or instructions, notes regarding the last visit, etc. 

When you have completed the Add Unit form, you may either click the OK button to save the 
information and close the form or you may click on the Cancel button again to abandon the Add Unit 
process without saving. In either case, you will be returned to the Units form, where you may repeat the 
process to add another unit, delete or edit an existing unit, or close the form and return to the main alert 
logging window. 
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Deleting a monitor from the database 

The Delete button will delete the monitor whose entry is currently displayed in the Units form. You will 
be asked to confirm the deletion as indicated in Fig. 4.4. Chose Yes or No as appropriate and you will 
be returned to the Units form. Any entry erroneously deleted must be re-entered in its entirety. 

 
Figure 4.4 

 
Editing a monitor database entry 

The Edit button will display the same form (fig. 4.5) used to originally enter monitor information. Any 
field may be edited and saved. 

 

 
Figure 4.5 
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Finding a monitor in the Units database 

As the database grows, it may be useful to use the Find button to quickly move to the correct entry. 

 
Figure 4.6 

 
If the four-digit Site ID specified is not in the database, a Not Found warning (fig. 4.7) will be displayed. 
Click OK to clear the warning. When the Site ID is found it will be displayed in the Units form. 

 
Figure 4.7 

 

 
Figure 4.8 

 
Connecting to a monitor in the Units database 

The technician may connect by modem to any unit displayed in the Units database by clicking the Call 
Unit button. An ANSI terminal window will open for interactive connection with the monitor. It is a good 
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idea to perform this check whenever a new monitor is added to the database. If the Call Unit button is 
erroneously clicked, the call can be aborted by pressing the <Esc> key. 

Customizing User Friendly Local Alert Messages 

Building Customized Alert Messages 

This feature, accessed via the Customize > Alert Descriptions menu path, allows technical staff to map 
machine messages from PageTek monitors to a user-friendly statement that is more easily understood 
by non-technical personnel. While this is most useful when a call or dispatch center receives the alerts 
from monitors, it allows all users to more quickly and easily recognize the nature of the failure. It also 
can permit a greater variety of messages to be displayed at the monitoring center. The initial window to 
appear will be entitled Customize Call Descriptions. The customized call message may be mapped to 
any combination of Region, Site ID or Site ID range and Input Name. When a received alert message 
contains all specified parameters as indicated in this box, a customized message is generated. Any or 
all of these parameters may be selected as required. 

 

 
Figure 4.9 
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Figure 4.10 

 
Click on the check boxes to select the desired parameters. 

1) If desired, select the Region for which the Call Description rule is being constructed. The 
regions available for selection are those previously programmed using the Customize Regions 
command. 

2) If desired, enter the Site ID for which the Call Description rule is being constructed  
3) If desired, check the Input Name checkbox to enter the Input Name for which the Call 

Description rule is being constructed. This phrase must exactly match the Input descriptor 
programmed in the monitor issuing the alert messages 

 
A sample of the expected customized message is displayed in the lower part of the dialog box. In 
addition to the string-input fields in the upper portion of the box, there are several additional buttons 
namely: 
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Figure 4.11 

 
Occasionally, the PSTN (Public Switch Telephone Network) may be in a state in which 
communications either is compromised. The most frequent occurrence would a failure of the telephone 
line such that set up or torn down correctly by the SiteManager and/or monitor modems. In such a 
case, SiteManager will display a warning such as shown in the figure below.  

 

 
Figure 4.12 

 
When this occurs, the status indication in the lower left-hand corner of the main window may provide 
additional information about the communications state. Most often the indication will be “Releasing 
Call”, indicating that the connection was not torn down correctly due to the connection being lost 
prematurely. If the failure is local to the monitor site, all other monitor calls will continue to be received 
although the warning remains unacknowledged. Acknowledge the warning by clicking on the OK. 
Operator interaction with SiteManager will not be possible until OK is clicked but background processes 
will continue. Occasionally, a modem may wedge and become unresponsive to the TAPI function used 
by SiteManager. In this case, a power cycling of the modems may be required. 
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Adding Filter Criteria 

The Add button calls up the Add Criteria window, on which there are checkboxes for the Region, Site 
ID, Site ID Range, Input Name parameters. Checking any or all of these fields allows the parameter to 
be defined in the resulting input fields. Press the Create button to call up the Alert Descriptions Box in 
which the customized message may be built.  

 
Figure 4.13 

 
In performing this feature, the filter looks at the Site ID, Input ID and Input name in the incoming 
message and formats this in a phrase adhering to one of the following formats: 

1. <object phase> <verb phase>  
2. <object phase> <verb phase> <direct object>  
3. <object phase> <verb phase> <direct object> <measurement> 

 
To configure this facility, one must know the Site ID or Site ID range of the monitors requiring the 
mapping. A continuous range of Site IDs may be used, i.e., monitors having Site IDs of 1000 to 1025, 
inclusive may be mapped to the same user-friendly message if required. For this reason it is 
suggested, but not required, that monitors known to require the same message be programmed with 
continuous Site ID.   

A single Input ID may be designated using the appropriate format: 

ProTekTor+ I1 - I8 

jr+ A1-A4 (A1-A8 on the jr+4) D1=D8 I1-I4 

24+ 1A1-6A8 (Remember that up to 6 SIMs may be supported by the 24+) 0D1=6D8 
(Remember that the motherboard is considered SIM 0 but supports only digital inputs) 0I1-
6I8 (Remember that on the 24+ only digital inputs support activity monitoring.) Only a 
single input may be designated in the Input ID field. If multiple inputs require the same 
processed message, the configuration must be set for each instance. 

1. <object phase> <verb phase>     
2. <object phase> <verb phase> <direct object>   
3. <object phase> <verb phase> <direct object> <measurement>    
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Defining Regions and Locations 

Accessed via the Customize > Regions menu path, the Customize Regions facility allows the technical 
staff to designate Regions and Locations within those regions to which a monitor may be assigned.  To 
enter a new Region use the Tree > Add Regions command on Regions Window. The New Region dialog 
box will appear with the prompt “Name for new region:” Enter a name of up to 32 characters. 

 

 
Figure 4.14 
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Message Archives Searching  

 

Figure 4.15 

 

Building filters 

Accessed via the Customize > Filtering menu path, the technician may search for and retrieve 
messages based upon content. The parameters that may be specified include: 

�� Site Name: The name programmed in a monitor.  
�� Site ID: The Site ID programmed in a monitor.  
�� Alert Date: The date in the time stamp sent with every alert message.  
�� Alert Time: The time in the time stamp sent with every alert message. 
�� Input Name: The Input Name programmed for an input in a monitor. 
�� Input Value: The dynamic value indicated by any alert message. 
�� Description: Any part of the Description displayed in the Alert Message window lower pane.   

 

These parameters may be either a specific value or a continuous range of values, including initial and 
end values. The string specified is not case sensitive but must otherwise match exactly for correct 
retrieval. This facility enables the technician to search for a particular trouble across the entire network, 
for messages related only to a specific site or time, etc. Multiple criteria may be used for the search. It is 
also permissible to use wildcards when filtering by description. Behavior of the allowed wildcards is 
indicated in the table below: 
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Kind of match Pattern  Match  No match 
Multiple characters a*a aa, aBa, aBBBa aBC 
 ab abc, AABB, Xab aZb, bac 
Special character a[*]a a*a aaa 
Multiple characters ab* abcdefg, abc cab, aab 
Single character a?a aaa, a3a, aBa aBBBa 
Single digit a#a a0a, a1a, a2a aaa, a10a 
Range of characters [a-z] f, p, j 2, & 
Outside a range [!a-z] 9, &, % b, a 
Not a digit [!0-9] A, a, &, ~ 0, 1, 9 
Combined a[!b-m]# An9, az0, a99 abc, aj0 

Figure 4.16 

 
The following should be kept in mind while filtering messages: 

�� Message filtering is not case sensitive. 

�� Ranges are exclusive in message filtering. 

�� Message filtering of Alert time is original time monitor initiated alert this is visible in Call 
details window but not in Alert Calls message window string. Use description contains 
string if searching for catching time is needed. 

�� Input name is not Input number. 

�� Input value must include the units token. 

�� Partial string search works only with consecutive words. 

 
Scheduling of SiteManager Initiated Paging 

Building a schedule 

Accessed via the Customize > Scheduling menu path, this command opens the Scheduling dialog box. 
If no Technicians have been entered yet (as will be the case during initial installation), the prompt 
“Press ‘View Technicians’ to enter technicians in the database for scheduling.” will appear. Click OK 
and press “View Technicians” to enter at least one technician. A dialog box labeled Customize 
Message will appear. Enter the technicians name or ID in the Technician Call Name field. 

The Region list box contains the regions that have been programmed by the SiteManager user using 
the Customize Region utility. New regions may be entered by returning to the Customize Region utility. 

The technician list box contains the technicians that have been programmed by the SiteManager user 
using the View Technicians utility accessed by the View Technicians button on this page. 

The View Technician button brings up the Customize Message window, from which one may add, delete 
or edit a Technician entry.  To add a technician press the Add button and enter the technician name in 
the Technician Call Name Box and the number of the technicians pager. Be sure to include the 
complete number including out dialing prefix, long distance access etc exactly as dialed. The horizontal 
scroll bar may be used to step through the current entries in the Technician list. To delete any 
technician from the list press the Delete button while that technician is visible. To modify any technician 
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entry, click Edit and edit the information as required, clicking OK when complete Each Regions may be 
assigned a Notification Schedule using this utility. One or more technicians may then be assigned to 
the regions. Each technician may be assigned to one or more regions. 

To designate a schedule for a particular technician and region combination select the technician and 
region using the drop down list boxes. If a single schedule is to be adhered to for all weekdays and/or 
all weekends then that schedule may be entered only once and it will be duplicated for all weekdays. A 
similar capability is available for the weekend days as well. 

The Schedule for any particular day need not be a single contiguous period. It can be multiple periods 
throughout any 24-hour period, i.e., a schedule could be from 4:00 AM to 8:00 AM and from 3:00 PM to 
6:00 PM. The designated schedule will be indicated visually in the Gantt chart in the window center. 
After the desired schedule has been entered, press the SET button to commit the schedule to memory. 

To enter a schedule for any day or period check the checkbox for that day. The ADD and Clear buttons 
associated with that day will become active. Press the Add button the call up the Add Block window, on 
which field are available for the String and Ending Time of the block of time to be scheduled. The time 
may be entered in 24-hour format (1400) or may be entered using the AM or PM suffixes. If AM or PM 
suffixes are not used the entry in presumed to be in 24-hour format. If block programmed overlaps a 
previously programmed block of time then the two entries, this will be indicated by multiple end point 
markers along an apparently continuous line. While multiple blocks of time may be scheduled for the 
same day by repeating the Add procedure the Clear button will delete all blocks of time associated with 
that day or period,. For this reason, carefully confirm each entry in a multiple entry schedule before 
clicking Add on the Add Block window. Press the Cancel button if you decide not to add another time 
block to the schedule. 

 

Figure 4.17 
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Figure 4.18 
 

 

Figure 4.19 
 

Green bars as seen in figure 4.19 indicate that a schedule is part of a global assignment of weekend or 
weekday and has not been set individually. 
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Alternative use of the scheduling facility 

While the scheduling facility has been designed to primarily function in the manner indicated above, the 
application doesn’t really care what organizational paradigm is used. The user may, for instance, 
decide that organization by sub network is preferable to a geographical structure. One would therefore 
define Regions as perhaps cellular, paging, and trunking networks. This would make sense if a several 
technicians serving in the same geographical region were each responsible for a particular technology 
or infrastructure. While the Technician mapping must ultimately be to an entity responsible for 
responding to any alerts, it is possible that Technician would be defined as the HVAC, Generator, 
Network, and Infrastructure departments of a larger company or group of companies. 

User-friendly messages 

User friendly messages may be generated by the SiteManager using a combination of the values 
extracted from monitor-generated alerts, hard-coded vocabulary, and a phrase lexicon programmed by 
the user. A rules table partially hard coded and partially user programmable is used by the SiteManager 
in constructing a message of up to 256 characters. The following chart indicates the structure of the 
SiteManager generated user-friendly messages: 

Field Generator Source Characters Representative Content 

Token field SiteManager/
monitor 

Derived from the 
monitor input value 

token field. 
9 Watts, DC Volts, Degrees C 

Value field SiteManager/
monitor 

Derived from the 
monitor input value 

field. 
4 0.12, 1.20, 12.0 

Descriptor 
field 

SiteManager/
monitor 

Derived from the 
programmed input 

descriptor. 
16 Input Descriptor Faulty RF 

power Faulty Power Supply 

Prog. text 1 SiteManager 
Supervisor 

Supervisor 
programming 32  

Prog. text 2 SiteManager 
Supervisor 

Supervisor 
programming 32  

Prog. text 3 SiteManager 
Supervisor 

Supervisor 
programming 32  

Figure 4.20 
 
The SiteManager administrator may program up to X [mrball8]programmable message strings. Of 
these, any three may be programmed to be used by the SiteManager to automatically generate a user-
friendly message based upon alert message content.  As an example, the monitor-generated alert  

Alert-Site: 1111 - Raleigh, NC     * D8 PROTEK AC       * MAJ ALARM  * L  MAJ=D78 

would result is the user-friendly message 

“Raleigh, NC site 1111 AC Power has failed.” being generated.    

The above message is composed of <extracted site name “Raleigh, NC”> <SiteManager generated 
vocabulary “site”> <extracted site ID “1111”> <Object phrase “AC Power”> < Verb phrase “has failed”> 
after matching on the *D8 PROTEK AC phrase sent by the monitor. A table resides within the 
SiteManager that is programmed by the SiteManager administrator. 
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Input generating 

alarm 
Object 
phrase Noun phrase Verb phrase Value Token 

D8 AC Power  has failed   
OD1 Generator   is running   

D1 Link 
transmitter  has been inactive 45  minutes 

A1 Link 
transmitter RF power has failed  25 watts 

Figure 4.21 
 

A link transmitter failure would result in the following alert being sent by the monitor: 

Alert-Site: 1111 - Raleigh, NC     * A1  Link XMTR        * MAJ ALARM  * 48W  MAJ=A1 
 
and the following user-friendly message being generated by the SiteManager: 

“Raleigh, NC site 1111 Link transmitter has failed: RF power 48 watts.” 
 
The above message is composed of  “<extracted site name “Raleigh, NC”> <SiteManager generated 
vocabulary “site”>  <extracted site ID “1111”> <Object phrase “Link transmitter”> <Verb phrase “has 
failed”>  Noun phrase “RF power” <Value field “48”> < Token field  “watts”> after matching on the *A1  
Link XMTR phrase sent by the monitor 

Modem arbitration during outbound paging 

The alphanumeric alerts sent by the SiteManager to on-call technicians will be an abbreviated version 
of the user-friendly message programmed in SiteManager. Since this message is sent immediately 
after reception of the alert message from the remote monitor, it is possible that the outbound paging will 
be using the outbound modem immediately after the receipt of the message. If so, the Alert call window 
will indicate the modem is in use and the call unit functionality will temporarily be unavailable. Upon 
completion of the paging task the Call Unit buttons will initiate a terminal connection to the specified 
monitor as usual. 

Speeding up modem access of PageTek monitors 

Since all PageTek monitors have a maximum rate of 14.4 kbps, there can be an unduly prolonged 
negotiation phase as the SiteManager calling modem down trains from 56K to 14.4K. This can be 
corrected by configuring the calling modem to connect only at 14.4kbps or less, thereby shortening the 
negotiation phase. The initialization string for Conexant chipsets is generally XXX and this is installed 
by default in the standard PageTek SiteManager installation. The default manufacturer’s initialization for 
the listening modem is generally satisfactory.
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Chapter 

5 

Testing and Maintenance 

Testing the SiteManager Setup 

Now that there is a unit programmed in the SiteManager database, execute the following test to ensure 
that everything is functioning properly. 

SiteManager should be loaded and waiting to receive an incoming call. Be sure you have programmed 
the Report Deadline for that unit under the Units table for SiteManager. 

Use the command sequence View > Units to access the Units form. Chose a unit and click on the CALL 
button. A terminal window will open and SiteManager will call the unit selected. Once connected the 
password prompt will appear. At this point, log in to the monitor as normal and proceed to the 
command screen of the connected monitor. Type XST at the prompt, return to the Main menu and 
terminate the connection with the TC command. The XST command, which is not visible command on 
the menu, will generate a status call as soon as the connection is terminated with the TC command. 
The SiteManager should shortly receive a status call. The message should contain the correct time, 
Site ID, Site Name, etc. Connect to the monitor and select the system parameters screen. Reprogram 
the time of day for the unit to 5 minutes before a scheduled Status Report call and close the 
connection. 

When the status report call is received and is displayed in the Alert Call window, click on the View 
menu and select Status. The Status screen will be displayed with the last status report call in the 
window. If the unit’s SITE ID was added properly to the database, then the status report screen will 
display the 4-digit SITE ID in the upper left window and the full text of the call in the large window below 

We want to generate a major alarm to trigger a call to the SiteManager. Use the command sequence 
View > Units to access the Units form. Chose a unit and click on the CALL button. A terminal window 
will open and SiteManager will call the unit selected. Once connected the password prompt will appear. 
At this point, log in to the monitor as normal and proceed to the input configuration screen. Configure 
any input in such a manner that its current state will result in an alarm being generated. An alert call 
should now initiated by the monitor and an alert shortly be logged by the SiteManager, 

When the SiteManager telephone line rings, SiteManager will answer automatically. A dialog box will 
be displayed with “Incoming call…” on the screen. SiteManager will record the alert call and display it in 
the Alert Call window on the main screen. Below that window, the different portions of the alert call will 
be categorized and displayed.  

Reconnect to the PageTek monitor and disable the input you just programmed. Then acknowledge the 
alarm. You may set the input to unprogrammed if you wish. 

SiteManager now has the alert call displayed in the Alert Call window. 



 

If neither the status call nor the alert call is received, ensure that the SiteManager phone number is in 
telephone slot one of the PageTek monitor that failed to report. If the number is correctly programmed, 
ensure that the listening modem is properly installed and configured. 

If the status call is not received but the alert call is received, confirm that the PageTek monitor failing to 
send the status call has the SiteManager Telephone number correctly programmed in phone slot one. 
The receipt of the alert call indicates that the SiteManager incoming modem is operating correctly. 

If the status call is received by the alert call is not received, ensure that the number one telephone slot 
is correctly programmed in the calling sequence of the monitor that failed to report. Again, the receipt of 
the status call indicates that the SiteManager incoming modem is operating correctly. 

Database Maintenance 

There is intentionally no way for the site data stored by the SiteManager to be modified from within the 
application. The data is stored, however, in a database format that may be directly opened in Microsoft 
Access. The data file will be found in the directory in which the SiteManager software was installed, 
generally c:\program files\SiteManager on an NT 4.0 system. Since the file is saved with the mdb 
extension, simply double-clicking on the file in the Explorer file manager will result in Access loading the 
file. At that point, any controls available in Access may be applied to the file. Options include exporting 
to spreadsheet or word processing software for analysis or reports. 

Factory access of SiteManager software using PC Anywhere. 

The factory may ask to access your SiteManager installation for support, troubleshooting, or training 
purposes. PC Anywhere is generally installed for that purpose and may be configured to automatically 
begin running in the appropriate host mode. Generally, PC Anywhere host is configured to be 
accessible via PSTN and/or TCP/IP network.  

The default password has been set to pagetek with pagetek set as the user name. You have the option 
of disabling this access right at any time and later enabling a password of your choice if you require 
technical assistance. Other PC Anywhere users may be enabled to allow technical staff to routinely 
access the SiteManager software from other locations. For further information about PC Anywhere 
refer to the Symantec documentation. 

A log file is written to the SiteManager directory whenever the SiteManager application is opened. This 
log may be used for troubleshooting in the event of problems and its contents may be requested by 
PageTek during customer support. 

At 9/28/2001 7:44:39 AM : Opened Log 
At 9/28/2001 7:44:41 AM : Copy PSM_INIT.MDB -> PSM_DATA.MDB 
At 9/28/2001 7:44:41 AM : PSM_DATA.MDB Open 
At 9/28/2001 7:44:41 AM : Alert / Query Open Today 
At 9/28/2001 7:44:41 AM : Alert / Check EOF 
At 9/28/2001 7:44:41 AM : Status / Query Open 
At 9/28/2001 7:44:41 AM : Status / Check EOF 
At 9/28/2001 7:44:41 AM : Load Main Form 
At 9/28/2001 7:44:41 AM : Main Form Reformat 
At 9/28/2001 7:44:41 AM : Main/Load Listening Modem Init 
At 9/28/2001 7:44:43 AM : Outgoing Modem Init 
At 9/28/2001 7:44:43 AM : Find Status Report Deadline 
At 9/28/2001 7:44:43 AM : Show Main 
At 9/28/2001 7:44:54 AM : Initial Alert List Population 
At 9/29/2001 12:06:36 AM : Finding First Status Report Deadline of the day 
At 9/29/2001 12:06:36 AM : Day Change 
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At 9/30/2001 12:09:05 AM : Finding First Status Report Deadline of the day 
At 9/30/2001 12:09:05 AM : Day Change 

At 9/30/2001 9:42:35 AM : Exiting Program 
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Installed files  

The following files are installed during a SiteManager installation on an NT 4 system. The system files 
will be installed only if not already present or if newer than on those already installed on the system: 

AsycFilt.dll  
ComCat.dll  
COMDLG32.OC_  
Ctl3d32.dll  
dao350.dll  
EXPSRV.dll  
mci32.oc_  
mfc40.dll  
Mscomctl.oc_  
MSJet35.dll  
MSJInt35.dll  
MSJtEr35.dll  
MSRD2x35.dll  
MsRepl35.dll  
MSVBVM50.dll  
MSVCRT40.dll  
ODBCJI32.dll  
ODBCJt32.dll  

ODBCTL32.dll  
OleAut32.dll  
OlePro32.dll  
pdqcom32.oc_  
PDQTAPI.OC_  
psm_init.mda  
SETUP.EXE  
SETUP.LST  
setup1.ex_  
SiteMan.CN_  
SiteMan.hl_  
SiteManager.DE_  
SiteManager.exe  
ST5UNST.EX_  
StdOle2.tl_  
VB5DB.dll  
VB5StKit.dll  
VBAJet32.dll  

 
Windows 2000 Operating System 
Many of the DLL files that must be installed by SiteManager during an NT installation are now installed as a 
part of the standard Windows 2000. operating system. 
 
MCI32.DEP  
MCI32.oca  
MCI32.OCX  
MSWINSCK.oca  
MSWINSCK.OCX  
pdqcom32.ocx  

PDQTAPI.oca  
Pdqtapi.ocx  
psm_init.mdb  
SiteManager.exe  
VB5DB.dll 
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SiteManager ® version 1.4 software license agreement 

PageTek, Incorporated ® (“PageTek”) is willing to license its SiteManager version 1.4 software and the accompanying documentation to you only on the 

condition that you accept and agree to all of the terms in this agreement. If you do not agree to these terms, PageTek is unwilling to and does not license the 

software to you. If you do not agree to these terms you must discontinue the installation process. Any use of the software by you is subject to the terms and 

conditions set forth herein. 

1. License. Subject to the terms and conditions of this license agreement, PageTek hereby grants you a nonexclusive license to install and use the software 

in machine-readable form on one computer for use with a number of PageTek monitors as specified at time of purchase. The License Key assigned to the 

installation by PageTek will automatically limit the number of monitors supported by the SiteManager database. You may copy the software only for backup 

purposes, provided that you reproduce all copyright and other proprietary notices that are on the original copy of the software. 

2. Restrictions. PageTek retains all right, title, and interest in and to the software, and any rights not expressly granted to you herein are reserved by 

PageTek. You may not reverse engineer, disassemble, decompile, or translate the software, or otherwise attempt to derive the source code of the software, 

except to the extent (if at all) expressly permitted under any applicable law. If applicable law expressly permits such activities, any information so discovered 

or derived shall be deemed to be the confidential proprietary information of PageTek and must be promptly disclosed by you to PageTek. Any attempt to 

transfer any of the rights, duties or obligations hereunder is void. You may not rent, lease or loan the software. You may not reproduce (except as expressly 

permitted under section 1), distribute, publicly perform, publicly display, modify or create derivative works of or based on the software. 

3. Technical support. Limited technical support (via telephone or email response) may be available for a limited period of time if you use the software in 

permanent mode or demo mode. 

4. Limited Warranty. PageTek warrants to you that the Software will perform substantially in accordance with the Documentation for the ninety (90) day 

period following your receipt of the Software. To make a warranty claim, you must return the Software to PageTek along with proof of purchase within such 

ninety (90) day period. If the Software does not perform substantially in accordance with the Documentation, the entire liability of PageTek and your exclusive 

remedy shall be limited to either, at PageTek’s option, the replacement of the Software or the refund of the license fee you paid for the Software. The 

foregoing states the sole and exclusive remedies for PageTek’s breach of warranty. The limited warranty set forth in this section gives you specific legal 

rights. You may have other rights which vary from state to state or jurisdiction to jurisdiction. 

5. Disclaimer of warranties. Except for the limited warranty set forth in section 4, PageTek makes no warranties, express, implied or statutory, as to any other 

matters, including but not limited to non-infringement of third party rights, merchantability, or fitness for any particular purpose. PageTek and its suppliers do 

not and cannot warrant the performance or results you may obtain by using the software. Some states or jurisdictions do not allow the exclusion of implied 

warranties or limitations on how long an implied warranty may last, so the above limitations may not apply to you. To the extent permissible, any implied 

warranties are limited to ninety (90) days. 

6. Limitation of liability. To the maximum extent permitted under applicable laws, under no circumstances, including negligence, shall PageTek, its affiliates or 

their directors, officers, employees or agents be liable for any indirect, incidental, special, punitive or consequential damages (including but not limited to 

damages for loss of business profits, business interruption, loss of business information and the like) arising out of the use or inability to use the software, 

even if PageTek or its authorized representative has been advised of the possibility of such damages. Some jurisdictions do not allow the limitation or 

exclusion of liability for incidental or consequential damages so the above limitation or exclusion may not apply. In no event shall PageTek’s total liability to 

you for any and all damages, losses, claims and causes of actions (whether in contract, tort, including negligence, or otherwise) exceed the greater of the 

amount paid by you for the software or $10.  

7. Indemnity. You agree to defend and indemnify PageTek against all any and all claims, losses, liabilities, damages, costs and expenses, including 

attorney’s fees, which PageTek may incur as a result of or in connection with your breach of this agreement. 

8. Term and termination. This agreement shall continue until terminated. You may terminate the agreement at any time by deleting all copies of the software 

and all related information. This agreement terminates immediately and automatically, with or without notice, if you fail to comply with any provision hereof. 

Additionally, PageTek may at any time terminate this agreement, without cause, upon notice to you. Upon termination you must delete or destroy all copies 

of the software in your possession. Sections 2 through 6, and 11 survive termination. 

9. Government end users. If you are or are acting on behalf of an agency or instrumentality of the United States government, the software, as applicable, is 

“commercial computer software” and “commercial computer software documentation” and pursuant to FAR 12.212 or DFARS 227 7202 and their 

successors, as applicable, use, reproduction and disclosure of the software is governed by the terms of this agreement. 

10. Contracting parties. If the software is installed on any computer owned by a corporation or other legal entity, then this agreement is formed by and 

between PageTek and such entity. The individual executing this agreement represents and warrants to PageTek that they have the authority to bind such 

entity to the terms and conditions of this agreement. 

11. General. This agreement is governed and interpreted in accordance with the laws of the state of North Carolina without giving effect to its conflict of laws 

provisions. The United Nations convention on contracts for the international sale of goods is expressly disclaimed and shall not apply. Any claim arising out of 

or related to this agreement must be brought exclusively in a federal or state court located in wake county, North Carolina and you consent to the jurisdiction 

of such courts. If any provision of this agreement shall be invalid, the validity of the remaining provisions of this agreement shall not be affected. This 

agreement is the entire and exclusive agreement between PageTek and you with respect to the software and supersedes all prior agreements (whether 

written or oral) and other communications between PageTek and you with respect to the software. 

Copyright © 2001 by PageTek Incorporated. All rights reserved.  

PageTek® is a registered trademark and registered service mark of PageTek Incorporated. 
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